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Overview

About this manual

This manual describes how to use Cutting PowerPac to create cutting programs offline. It also 

explains Cutting PowerPac terms and concepts.

Who should read this manual?

This manual should be used by anyone working with Cutting PowerPac.

Usage

This reference manual contains general and specific information about the Cutting PowerPac 

tools and workflow.

Prerequisites

The reader should have a basic knowledge of:

• RobotStudio

• RAPID

• Cutting process

Organization of chapters

The manual is organized into the following chapters:

References

Revisions

Chapter Contents

1. Introduction and 
Installation on page 
7

Describes the installation, registration and setup of the Cutting 
PowerPac.

2. Cutting Ribbon-tab 
on page 13

Describes the functions of the dedicated tab for Cutting Pow-
erPac in the ribbon.

3. Cutting Browser on 
page 23

Describes the functions and menus of the Cutting browser.

4. Cutting path view 
on page 51

Describes the functions and menus of the path view.

5. Cutting PowerPac 
workflow on page 
109

Describes the basic workflow when working with Cutting 
PowerPac

Reference Document ID

3HAC032104-001 Operating Manual - RobotStudio

3HAC043508-001 Application Manual - RW Cutting

Revision Description

- First edition
53HAC043509-001  Revision: -     
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1 Introduction and Installation

1.1. Introduction to Cutting PowerPac
1 Introduction and Installation

1.1. Introduction to Cutting PowerPac

About Cutting PowerPac

Cutting PowerPac is a dedicated tool for generating cutting programs in RobotStudio. 

Utilizing the CAD geometry as the basis for all robotics programming, you can generate 2D 

shape cutting instructions based on geometry features, and also generate free form cutting 

path base on the edges. This method, known as geometry-based offline programming, gives 

you unprecedented control over the cutting paths, resulting in improved quality.

About this chapter

This chapter will guide you through the installation process, which consists of these steps:

• Installing Cutting PowerPac on page 8.

• Accessing the user interface on page 9.

Prerequisites

To complete the installation process, you must have the following items at hand:

• RobotStudio and RobotWare Cutting installed on your computer, which fulfils the 

system requirements

• Cutting PowerPac installation package

• A license certificate

• A logon account with administrator rights
73HAC043509-001  Revision: -     



1 Introduction and Installation

1.2. Installing Cutting PowerPac
1.2. Installing Cutting PowerPac

Overview

To be able to install Cutting PowerPac, RobotStudio and RobotWare Cutting must be installed 

on your computer.

Installing Cutting PowerPac

To install the Cutting PowerPac, follow these steps:

1. Browse to Cutting PowerPac installation package and double-click Setup.exe.

The installation opens. 

2. Click Install Cutting PowerPac.

The installation starts.

3. Read the License Agreement and accept the terms.

4. Click Install.

5. When the installation is finished, complete the installation wizard by clicking Finish.

Installing a License

The procedure of installing a license is the same as that of RobotStudio.
3HAC043509-001  Revision: -8
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1.3. Accessing the user interface

Overview

Before you can start using Cutting PowerPac, you must load a RobotStudio station that 

includes at least one cutting robot. The virtual controller (VC) associated with the cutting 

robot must be loaded.

Loading a station

To initially open a station, follow these steps:

1. Open RobotStudio and create a new station with an existing system.

2. On the Add-Ins tab in the ribbon, select Cutting from the PowerPacs group.

A dedicated tab for Cutting is added to the ribbon.

The Cutting tree structure browser opens.

3. Expand the tree structure of the Cutting browser and right-click Part Programs. Then 

click Create part. In the dialog box, click OK.

4. Right-click the created path and click Open to open the path view.

The user interface

The panes and windows of the user interface, described in the following figure, help you to 

create a well-structured cutting program.

RSPP00001
93HAC043509-001  Revision: -     
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1 Introduction and Installation

1.3. Accessing the user interface

Continued
Item Description

1. Cutting ribbon-tab Contains the general functions for Cutting process.

See Cutting Ribbon-tab on page 13 for detailed description.

2. Cutting browser Organizes the components of the station in a tree structure.

See Cutting Browser on page 23for detailed description.

3. Path view Categorizes and linearly maps the targets.

See Cutting path view on page 51 for detailed description.

4. Tool window Dialog boxes created from the Path View.

Enables you to create new instructions and modify existing 
instructions.

5. Graphics window The graphics window is coordinated with these panes: a path 
highlighted in the browser, is highlighted with the same color 
in the graphics window. A simulation appearing in the 
graphics window is represented in the path view by a robot 
cursor stepping through the path in the path view.

The graphics window is an important source to input geometry 
targets. By clicking on the part models in the window, you can 
create or modify a target in the geometry space.
3HAC043509-001  Revision: -10
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1.4. Concepts

Reference Coordinate System (RCS)

In Cutting PowerPac, every robtarget is associated with a local reference coordinate system 

called Reference Coordinate System (RCS). 

RCS is primarily used to help create and manipulate targets in RobotStudio. As workobject/

UCS, RCS can be used to set the target location and angle.

Usually a target's RCS accommodates the shape of the part geometry. For example, for 

cutting targets along a cut path, the RCS positions are along the cut path, the x axis directions 

are along the path direction, and the z axis directions are along the normal vector of the cut 

surface. Thus, instead of entering target values in relation to a world coordinate or a work 

object, you can specify offsets and angles relative to the RCS, which have a more direct space 

relationship between robot targets and the cut.

RSPP00002

Process templates

A process template in Cutting PowerPac is a collection of templates for process parameters, 

cutting targets, instruction arguments, and so on. It specifies the information needed to create 

a complete cutting on the part. Cutting PowerPac is installed with default process templates, 

such as ProcessAsMove and CutDefault.

Generic data

Besides default RAPID data types, such as robtarget and tooldata, PowerPacs also uses other 

data types. These are called generic data. 

In Cutting PowerPac, some process related data, such as cutdata, leaddata, and fricdata are 

supported.
113HAC043509-001  Revision: -     
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2.1. Overview
2 Cutting Ribbon-tab

2.1. Overview

Overview

The Cutting ribbon-tab contains the controls for creating paths, virtual controller operations, 

modifying Cutting PowerPac data, and help information.

RSPP00003
133HAC043509-001  Revision: -     
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2 Cutting Ribbon-tab

2.1. Overview

Continued
Elements on the Cutting ribbon-tab

Group Button Description

Create Part Program

RSPP00004

Opens a dialog box to insert a new part node into 
the tree structure and creates an empty path.

Only available when the Part Program node or a 
part node is selected in the Cutting browser.

NOTE! You can access this function also from 
the Cutting browser by right-clicking the Part 
Programs node.

See Part Programs node on page 32 for the 
definition for part program.

Process Path

RSPP00005

Inserts a new path node into the tree structure. 
Not available on an open path.

Only available when a part node or a path node 
under the part node is selected in the Cutting 
browser.

NOTE! You can access this function also from 
the Cutting browser by right-clicking the Process 
Path node.

See Process path on page 40for the definition for 
process path.

Setup Path

RSPP00006

Inserts a new path node into the tree structure.

Only available when the Setup Procedures node 
or a path node under the Setup Procedures node 
is selected from the Cutting browser.

NOTE! You can access this function also from 
the Cutting browser by right-clicking the Setup 
Procedures node.

See Setup and service procedures on page 46for 
the definition for setup path.

Service Path

RSPP00007

Inserts a new path node into the tree structure.

Only available when the Service Procedures 
node or a path node under the Service 
Procedures node is selected in the Cutting 
browser.

NOTE! You can access this function also from 
the Cutting browser by right-clicking the Service 
Procedures node.

See Setup and service procedures on page 46.

Path Section

RSPP00008

Opens a dialog box to select sequential adjacent 
edges from the CAD model to represent a free 
form path, and saves the path data into a XML file 
which will be used to create a free form cutting 
path in the future steps.Always avail-
able.SeeCreate Free Form Path Data File on 
page 59 for detail.

2D Shape Data

RSPP00009

Opens a dialog box to select a face from the CAD 
model, and saves the corresponding 2D shape 
data into a .cad file which will be used to create a 
2D shape cut instruction.Always available.See 
Create Shape Data From Edges Dialog Box on 
page 80 for detail.
3HAC043509-001  Revision: -14
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2 Cutting Ribbon-tab

2.1. Overview

Continued
Virtual Controller Save Program

RSPP00010

Saves the current program in the virtual 
controller.

The program is saved to a predefined directory. 
Under the system’s home directory, a specific 
folder is created to store the RAPID programs for 
every task in the system. 

The folder name is: Station name"_"Task name.

For example, for the task T_ROB1 in station 
Irb140_250A_RW_5_11, its storing directory is 
HOME\Irb140_250A_RW_5_11_T_ROB1.

Options

RSPP00011

Opens an dialog box to set the synchronization 
settings.

Task Load Default 
Program

RSPP00012

Overwrites the current program in the virtual 
controller with an empty one.

Data Manager

RSPP00013

Opens the Data Manager dialog box, which lists 
all the related data in the current station.

Only available when the task node is selected in 
the Cutting browser.

SeeTask group on page 19 for the detailed 
description of data manager.

Help Cutting Help

RSPP00014

Provides the following information:

• Contents, the help file

• About Cutting PowerPac, version 
information

Group Button Description
153HAC043509-001  Revision: -     
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2.2. Creating group

Overview

All the functions in the Create group are available from the Cutting browse.

RSPP00015

Part Program

Click Part Program to open a dialog box to create a new part program. SeeCreating a part 

on page 34 for the detailed description.

This button is available only when the Part Program node or a part node is selected in the tree 

structure.

Process Path

Click Process Path to insert a new empty path node into the tree structure.

This button is available only when a part node or a path node under the part node is selected.

Setup Path/Service Path

Click Setup Path/Service Path to open a dialog box to create a new setup path or service 

path.

This button is available only when the Setup/Service Procedures node or a path under the 

Setup/Service Procedure node is selected.

Path Section

Click Path Section to open a dialog box to select sequential adjacent edges from the CAD 

model to represent a free form path, and saves the path data into a XML file which will be 

used to create a free form cutting path in the future steps. See Create Free Form Path Data 

File on page 59 for detail.

This button is always available.

2D Shape Data

Click 2D Shape Data to open a dialog box to select a face from the CAD model, and saves 

the corresponding 2D shape data into a .cad file which will be used to create a 2D shape cut 

instruction. See Create Shape Data From Edges Dialog Box on page 80 for detail.

This button is always available.
3HAC043509-001  Revision: -16
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2.3. Virtual Controller group
2.3. Virtual Controller group

Overview

RSPP00016

The functions in this group are related to the virtual controller.

Saving a program

After synchronization, RAPID programs are stored in virtual controller. You can access these 

programs from the Offline tab of RobotStudio. For more information, see Operating manual 

- RobotStudio. You can also save the programs as files on your PC, which makes it possible 

to load them to other controllers, or real IRC5 controllers.

Click Save Program to save the programs in virtual controller as files. The RAPID programs 

are saved under "HOME" directory of the system folder. 

NOTE!

When saving a program to files, the RAPID program stored in the virtual controller is saved. 

To save modifications in the station, first synchronize them to the virtual controller, and then 

click Save Program.

Options

RSPP00017
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2 Cutting Ribbon-tab

2.3. Virtual Controller group

Continued
Click Options to open a dialog box, which contains the following options:

Group Item Description

Enable RC Mode Synchronization option.

If selected, this option is enabled for all the tasks 
in the current station.

It means that for variables that already exist in 
the virtual controller, synchronization will not 
override them. Only new variables will be 
created.

CutWare State Process On Indicate whether enable or disable process 
option.Used for offline simulation.

Cut Process On Indicate whether enable or disable cut process 
option. Used for offline simulation.

Friction Tune Indicate whether enable or disable frictiontun-
ingoption.Used for offline simulation.

Ilc Init Indicate whether enable or disable Ilc option 
which will replace the previous Ilc setting. Used 
for offline simulation.

Ilc Continue Indicate whether enable or disable Ilc option 
which will calculate the new Ilc data based on 
the previous Ilc setting.Used for off line 
simulation.

Create LogFile Indicate whether enable or disable logfile op-
tion. Used for offline simulation.

Reset Path Mem-
ory

Clear the path memory.

Output Decimal 
Number

Specify the fraction number of output data in 
cutting instructions
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2 Cutting Ribbon-tab

2.4. Task group
2.4. Task group

Overview

RSPP00018

The functions in this group are related to the active task.

Load the default program

When you want to clean up the RAPID programs in the virtual controller, click Load Default 

Program to load an empty program to the virtual controller to overwrite the current one.

Data Manager

Click Data Manager to open the Data Editor. In Data Editor you can:

• Compare the data in the station with the date in the virtual controller.

• Synchronize data from the virtual controller to the station.

• Modify data other than default, such as fricdata, leaddata, and LsCutData.

RSPP00019
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2 Cutting Ribbon-tab

2.4. Task group

Continued
Synchronize data between virtual controller and station

Synchronizing ensures that the RAPID program in the system, running on the virtual 

controller, corresponds to the programs in Cutting PowerPac. You can synchronize data both 

from the station to the virtual controller and from the virtual controller to the station.

To synchronize the entire program stored in a robot system from the virtual controller to the 

station, follow these steps:

1. Select a task node from the Cutting browser, and click Data Manager to open the Data 

Editor.

2. Click Synchronize to Station.

To synchronize the entire program from the station to the virtual controller, refer to 

Synchronize to Virtual Controller in Shortcut menus from the task node on page 24.

To synchronize specific data between the virtual controller and the station, follow these steps:

1. Select a task node from the Cutting browser, and click Data Manager on the ribbon 

to open the Data Editor.

2. Click the "+" signs to expand the modules.

3. Click the data that you want to synchronize. An editor opens where you can view the 

data expression.

4. Click the up arrow to synchronize the data from the virtual controller to the station.

5. Click the down arrow to synchronize the data from the station to the virtual controller.

RSPP00020
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2 Cutting Ribbon-tab

2.4. Task group

Continued
NOTE!

• For data that is just created but not shown in the virtual controller, you can specify the 

type in virtual controller when synchronizing. The type can be Persistent, 

TaskPersistent, Constant, or Variable. For the data that is already shown in the 

virtual controller, this function is disabled.

• Only data of type other than robtarget and jointtarget can be synchronized 

from the virtual controller to the station.

Modify data

To modify data with Data Editor, follow these steps:

1. Select a task node from the Cutting browser and click Data Manager to open the Data 

Editor.

2. Click the “+” signs to expand the modules.

3. Click the data that you want to modify. A Data Editor opens where you can view the 

data expression. In Data Editor, you can modify the synchronize reference, the storage 

class in RAPID programs, and the values of the data itself.

4. Modify the data.

5. Click OK to make the changes take effect.

Each data item has a classification that is used to define in which modules data should end up 

in the virtual controller. The data classification will be used to set the module name property 

when the data is synchronized to the virtual controller. 

• Sync as Inline Data: This selection is only available for jointtargets and robtargets. 

The data will not be declared but included in the instruction.

• Sync to Program Module: The default setting for most data. The data will be 

synchronized to the same module as the procedure where it was used.

• Sync to Process Data Module: Default setting for data such as leaddata. The data will 

be synchronized to the module defined as Process Data Module, See task properties.

• Sync to Calibration Data Module: Default setting for data such as tooldata. The data 

will be synced to the module defined as Calibration Data Module, See task properties.

• Sync to Module: Name of the procedure to where the data will be synced. No update 

will be done during synchronization.

NOTE!

The Storage Class selection is enabled only if data does not exist in the virtual controller; 

otherwise it will simply use the storage class of the data in the virtual controller.
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2.4. Task group
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3.1. Overview
3 Cutting Browser

3.1. Overview

Overview

The tree structure of the Cutting browser provides an overview of the controllers, robots, 

templates, and programs.

RSPP00021
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3.2. Task node
3.2. Task node

Overview

You can access the shortcut menus for the task node (top node) in the Cutting browser by 

right-clicking the task node.

Shortcut menus from the task node

Menu
Dialog Box 
Elements

Description

Properties Allows you to specify the following properties for the 
selected task:

RSPP00022

Application From the options selected in the virtual controller, the 
system determines the application suitable to the 
robot type. If the robot is for laser cutting, an 
appropriate move and action instruction set will be 
imported to the station.

Default Move to 
Home 
Procedure

This optional property adds a procedure before the 
first cutting of every part program. This is usually the 
starting point for the first cutting, ensuring that the 
robot can actually move to the first instruction in the 
first cutting.

Calibration Data 
Module

This optional property puts all workobjects and 
tooldata in the specified module when synchronizing 
with the virtual controller. You can map it to a specific 
RAPID module in the virtual controller.

Process Data 
Module

This mandatory property puts all process data in the 
specified module when synchronizing with the virtual 
controller. You can map it to a specific RAPID module 
in the virtual controller.

Default Path 
Color

This optional property sets the color used to highlight 
open paths in the Cutting browser and the path view.

Refresh Refreshes the browser to reflect changes in the path 
view.

Import Action 
Instruction

Imports predefined action instructions.
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3 Cutting Browser

3.2. Task node

Continued
Import Action Instruction/Move Instruction/Move Instruction Description

Some default move instructions are always available in the controller after the RobotStudio 

and Cutting PowerPac are installed. 

To be able to use instructions other than default, it is necessary to tell RobotStudio how these 

instructions should be handled.

Follow these steps to import instructions:

1. Right-click a task node and click Import Action Instruction/Import Move Instruction 

Description/Import Move Instruction. A dialog box opens.

2. In Look in, browse to the location where you stored the instruction files (*.xml).

3. Select the desired file and click Open to import the selected file to the current task.

A default set of action instructions and move instruction can be automatically imported when 

you open a system for the first time:

RSPP00023

Click Yes to automatically load the templates files. Click No to deny automatic loading. Click 

Cancel to skip automatic loading this time.

Default directories are: 

• /HOME/RS of the system folder. This will be ignored if not present.

• /MyDocument/RobotStudio/ProcessPac/

See Operating Manual - RobotStudio for the definition of Action Instruction, Move 

Instruction and Move Instruction Description.

Import Move 
Instruction 
Description

Imports predefined move instruction descriptions.

Import Move 
Instruction

Imports predefined move instructions.

Synchronize to 
Virtual 
Controller

Synchronizes the entire task to the virtual controller. 

NOTE! Since the Synchronize to Virtual Controller 
is available from the shortcut menu in Cutting 
PowerPac, the Synchronize to virtual controller 
function in RobotStudio’s Offline tab will be disabled.

Menu
Dialog Box 
Elements

Description
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3.3 Templates

3.3.1. Process templates

Overview

A process template is a collection of process parameters and instruction settings that define 

the properties of a cutting instruction. 

The process template is used to set process parameters on a cutting instruction, when the 

Create Cutting function is executed. 

Shortcut menus from the Process Templates node

Importing a process template

The process templates are based on several instructions. For example, the ProcessAsMove 

template includes instructions for MoveL, MoveJ and MoveC. These default move 

instructions are always available in the virtual controller. The Cut Default template (included 

in the Cutting PowerPac installation) uses instructions such as CutL and CutC. These are 

available in a virtual controller installed with the option Cutting.

1. Right-click the process node and click Import. In the Import Process Template dialog 

box, select the corresponding template and click Open.

2. An error message appears if the underlying instructions for the template are not found in 

the controller. In this case, RobotStudio must be told how these instructions should be 

handled. This should be done manually in the Instruction Template Manager in 

RobotStudio or by importing a predefined description file.

If the template is successfully imported, the related process definitions will be 

automatically added into RobotStudio. Do not manually modify or delete any of these 

process definitions in the Instruction Template Manager.

Modifying process templates

1. In the Cutting browser, right-click a template and click Properties to open a dialog box.

2. Modify any values. To store your changes without closing the dialog box, click Apply. To 

store your changes and close the dialog box, click OK. To close the dialog box without 

storing any changes, click Cancel.

Node Menu Description

Process Import... Imports predefined process 
templates.

Properties... Allows you to view and modify the 
properties of a process template.

Create Copy Creates a copy of a selected process 
template.

Save... Saves the selected process template 
to disk.

Delete Deletes the selected process 
template.
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3 Cutting Browser

3.3.1. Process templates

Continued
Process template properties

In the Cutting browser, right-click a template and click Properties to open a dialog box.

RSPP00024

Section Description

Description A data field for entering a text description of the process template. This 
information is not transferred to the RAPID code.

Process 
Parameters

Optional.

The values can be obtained from a Cutting case, or manually modified. 
If selected, the property values will be used as target settings in Create 
Free Form Cutting.

VirtualArc Case 
Name

A list of VirtualArc cases will be displayed here. If VirtualArc software is 
installed on the same computer, the button Edit Case is enabled. Click 
this button. VirtualArc opens with the selected case.

Base RS Process 
Definitions

A process template is associated with a RobotStudio base process 
definition file. The definition file contains all the instruction templates 
used by the process template, and is imported into RobotStudio by 
Cutting PowerPac.

Usually you do not need to change the association between a process 
template and a definition file. However if such a case occurs, you can 
select a different definition here, export the process template and 
import into Cutting PowerPac again.

Templates Templates section.

Settings for RAPID instructions. Instruction parameters (for example, 
motion type, speed, zone) will be set for all targets depending on the 
target classification.

If an argument is generic data, a Create new... appears in the drop-
down list. If selected, a dialog box opens to create a new data of this 
type.

An edit button beside the generic data is also available.

Clicking the button starts the Data Editor, where sync properties and 
data values can be modified. See Task group on page 19for more infor-
mation.
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3.3.1. Process templates

Continued
Target classification

The following figure illustrates a typical sequence of targets.
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Cutting targets will be assigned with process parameters in accordance with one of the 
following classifications:

Target Description

Air Move Intermediate target between cutting paths. Generates a MoveJ 
or MoveL instruction, depending on the motion type.

Approach Move The first target before a cutting path. Generates a MoveJ or 
MoveL instruction, depending on the motion type. Is connected 
to the following Process Start target, so that the orientation 
always follows the process start point with a variable approach 
distance.

Process Start The first target in a cutting path. Generates a CutLStart in-
struction, activating the cutting process.

Process Via The intermediate target in a cutting path. Generates a CutL or 
CutC instruction, depending on the motion type.

Process End The last target in a cutting path. Generates a CutLEnd or 
CutCEnd instruction, depending on the motion type, deacti-
vating the cutting process.

Depart Move The first target after a cutting path. Generates a MoveL instruc-
tion. It is connected to the preceding Process End Target, so 
that the orientation always follows the process end point with a 
variable depart distance.
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3.3.2. Cut templates
3.3.2. Cut templates

Overview

A cut template is a collection of cutting creation methods. See Create Free Form Cutting on 

page 59for detail.
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3.3.3. Search templates
3.3.3. Search templates

Overview

A search template is a collection of search instructions.

When the needed instruction descriptions are available in the station, you can import and use 

the search template to create search instructions.
3HAC043509-001  Revision: -30



3 Cutting Browser

3.3.4. Tool properties template
3.3.4. Tool properties template

Overview

Since the tool model in RobotStudio differs from the tool in reality, Cutting PowerPac must 

know the geometry of the activated tool to be able to calculate correct cutting head angles 

based on the search parameters.
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3.4 Part programs

3.4.1. Part Programs node

Overview

The Part Programs node is an owner of a part program. A part program is equivalent to a 

program module in RAPID (.mod). In the RAPID module, the part program is translated into 

a general RAPID procedure, which includes calls to other RAPID procedures in a sequence, 

where each procedure equals to a process path in the part program.

Shortcut menus from the Part Programs node

Node Menu Description

Part 
Programs

Create Part Program Inserts a new part node into the tree 
structure and creates an empty path.

NOTE! You can access this function 
also from the Cutting ribbon-tab.

Import Part Program Imports XML part files. A dialog box 
opens for specifying import reference, 
tool, workobject, part name, path 
name, module name, and so on. 

See Importing a part program on page 
37 for detailed description.

Part Properties Modifies the properties of part 
program with a dialog box. The 
content is the same as in the Create 
Part Program dialog box.

Open Opens the Path view window, and 
shows the selected node's path items 
in that window.

Create Part Program Inserts a new part program node into 
the tree structure and creates an 
empty path.

NOTE! You can access this function 
also from the Cutting ribbon-tab.

Create Process Path Inserts a new path node into the tree 
structure.

NOTE! You can access this function 
also from the Cutting ribbon-tab.

Synchronize to VC Synchronizes the selected part (and 
all included paths) to the virtual 
controller. Not available if any path in 
the part program is open.

Export Part Program Export part program into an XML file. 
The default name of the file consists of 
the task name and the part name. A 
dialog box opens for specifying the 
exporting reference frame. 

See Exporting a part program on page 
35 for detailed description.
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3 Cutting Browser

3.4.1. Part Programs node

Continued
Import Part Program Import an XML part file into station, as 
a part program. A dialog box opens for 
specifying import reference, tool, 
workobject, part name, path name, 
module name, and so on.

See Importing a part program on page 
37 for more description.

Import Path Import XML path file into this part, as a 
process path. A dialog box opens for 
specifying import reference, tool, 
workobject, path name and module 
name.

See Importing a path on page 44for 
more description.

Delete Deletes the selected node.

Node Menu Description
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3 Cutting Browser

3.4.1. Part Programs node

Continued
Creating a part

To create a part in a part program, follow these steps:

1. In the Cutting browser, select the Part Programs node or a part program node, right-click 

it and click Create Part Program..., or click Part Program in the Cutting ribbon-tab to 

open a dialog box.

RSPP00026

2. Enter all the needed information and click OK. If any RAPID names are invalid, clicking 

OK will not close the dialog box.

Object Description

Part Name Enter a name for the new part program.

Module Name Get automatic update when entering a new part name.

Include Part Data If selected, the created part program will also include a partdata. 
The information in the partdata is a collection of inputs in the 
following two fields.

Part Data - Description Get automatic update when entering a new part name.

Part Data - Load from 
Directory

If the module is loaded from the file system, this text specifies 
the directory.

Run in tasks Select tasks in which the created part program runs. This is 
useful when used in a MultiMove program.

Valid on Stations Select the stations for which this part data will be valid. The 
values should be numbers from 1 to 8.
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3 Cutting Browser

3.4.1. Part Programs node

Continued
After entering all the needed information, you can view the new part program in the tree 

structure of Cutting browser. If the part program is selected to be run in multi-tasks, a new 

part program node with the same name will be created under each task.

Exporting a part program

To export a part program into an XML file, follow these steps:

1. In the Cutting browser, select the Part Programs node or a part program node, right-click 

it and click Export Part Program to open a dialog box.

RSPP00027

2. Specify a name of the file and a directory to store.

The default name of the file is "Part_"+Task name+ "_" + Part name.

The default directory is under "/My Documents/RobotStudio/Stations".

PLC Code A unique integer number to indicate the part program ID in PLC 
code.

Advanced Part Data The partdata can be bound to an advanced path data.

Image File Select an image for the created part program. This image can 
be shown on Production Manager of the FlexPendant.

Path Before Select a path that runs before the created part program.

Path List Click Add to add new empty paths for the part program. You can 
also rename the new paths here.

Path After Select a path that runs after the created part program.

Object Description
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3 Cutting Browser

3.4.1. Part Programs node

Continued
3. Click Save and a dialog box opens.

4. Check the data and click OK. The XML file will be saved.

RSPP00028

Object Description

Description Describes the name of the part, the station, and the task. Read-
only.

Path The directory where the file is stored. Read-only.

File Name The name of the saved file.

Reference Frame A reference where the path targets in the part program are 
related to. This affects the position and rotation values of the 
targets. The references can be World Coordinate, User 
Coordinate System, robot base coordinate, or work object 
coordinate. 

Included Path The included paths to be exported are listed here. Besides 
paths in the selected part, service paths are also listed, in case 
you want to export service procedures together with the part 
program. Check the service procedures that you want to export 
together.
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3 Cutting Browser

3.4.1. Part Programs node

Continued
Importing a part program

A file can only be imported as the same object as it was exported. A part can only be imported 

as a part.

To import a part XML file into the station, please follow the steps:

1. In the Cutting browser, select the Part Programs node or a part program node, right-click 

it and click Import Part Program to open a dialog box.
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2. Select a part program file to import and click Open. A message box opens telling if a 

wrong type of XML file is selected.

If a wrong type of XML file is selected, a message is shown.
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3 Cutting Browser

3.4.1. Part Programs node

Continued
If a right type is selected, a dialog box opens.

3. Check the data and click OK. The XML file will be imported.

RSPP00030

Object Description

Description Describes the name of the part, the station, and the task. Read-
only.

Exported With Reference 
Frame

Used when the part program is exported. Read-only.

Import Reference Frame A reference to import part program. This affects the position and 
rotation values of the targets. The references can be World 
Coordinate, User Coordinate System, robot base coordinate, or 
work object coordinate.

Create New Program Data Select the check box to create a new copy of the included 
Program Module data; otherwise, old data will be referenced.

Restore Configuration 
Status

Select the check box to restore configuration status of the 
included targets to when they were exported. Otherwise, the 
configuration status is re-set to undefined.

NOTE! This is a lazy function. Make sure that the targets are 
indeed of the same configuration status.

Tool The tool for the part program. If left blank, the tool from the file 
will be used.

WorkObject Select workobject for targets in the part program. If left blank, 
the workobject from the file will be used.
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3 Cutting Browser

3.4.1. Part Programs node

Continued
NOTE! The following rules apply when creating new data and importing XML files:

• If the data is of program data type Sync to Program Module, new names will be 

created automatically, unless the Create New Program Data is unchecked.

• If the data is of another type, such as Sync to Process Data Module, new data will 

only be created if it is not present in the station. For example, a cutdata cd1 that is 

synchronized to the process data module will not be created again when importing. 

The old data cd1 will be used instead.

Module Name The synchronized RAPID module of the part program.

Path Name The name of the imported part.

Process Paths Names The name of the process paths in the part.

Object Description
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3.4.2. Process path

Overview

Process Paths are listed in the Cutting browser under the part programs. As a component of a 

part program, a path is a holder of cut in a sequence. Each cut includes a list of targets that 

constitute a continuous path. Paths can be dragged from one part to another; similarly, the 

order of paths in a part can be rearranged.

NOTE!

A process path created in the Cutting browser is also visible in the Elements browser. During 

synchronization with the virtual controller, the path is translated into a RAPID procedure.

Shortcut menu from the Process Path node

Node Menu Description 

Path Open Opens the path in the path view. Not 
available on an open path.

Create Process Path Inserts a new path node into the tree 
structure. Not available on an open 
path.

NOTE! You can access this function 
also from the Cutting ribbon-tab.

Synchronize to VC Synchronizes the selected path to the 
virtual controller. Not available on an 
open path.

Export Path Export a path into a XML file. The 
default name of the file consists of 
task name and path name. A dialog 
box opens for specifying the exporting 
reference frame. 

See Exporting a path on page 42for 
detailed description.

Import Path Import a path XML file into the current 
station as a process path. A dialog box 
opens for specifying the importing 
reference frame, tool, workobject, 
module, and path name. 

See Importing a path on page 44 for 
detailed description.

Visible With a check mark to indicate that the 
selected path is visible.

Not available on an open path.

Delete Delete the selected path. Not avail-
able on an open path.

Rename Rename the selected path. Not 
available on an open path.

Close Closes an open path, removing it from 
the path view. Only available on an 
open path.
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3 Cutting Browser

3.4.2. Process path

Continued
Creating process paths

There are three ways to create process paths:

• Add paths to the path list from the Create Part Program dialog box.

• Right-click a part program node and click Create Process Path.

• Click a part program node or a process path node, and click Process Path in the 

Create group of the Cutting ribbon-tab.

Creating Cuts

To add cuts to a path, first open the Path View by right-clicking a process path node and 

clicking Open.

See Create Free Form Cutting on page 59and The Shape Menu on page 74 for the detailed 

description of how to add cuts to the Process Path.
413HAC043509-001  Revision: -     

Continues on next page



3 Cutting Browser

3.4.2. Process path

Continued
Exporting a path

To export a path into an XML file, follow these steps:

1. In the Cutting browser, right-click a path, and click Export Path. A dialog box opens. 

Specify the name of the file and the directory to store.

The default name of the file is "Path_"+task name+"_"+path name. 

The default directory is under "/My Documents/RobotStudio/Stations".

RSPP00031

2. Click Save and the Export Path dialog box opens.

3. Complete the dialog box and click OK. The XML file will be saved.

RSPP00032
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3.4.2. Process path

Continued
Object Description

Description Describes the name of the path, the station, and the task. Read-
only.

Path The directory where the file is stored. Read-only.

File Name The name of the saved file.

Reference Frame Select a reference that the path targets in the path are related 
to. This affects the position and rotation values of these targets. 
The references can be World Coordinate, User Coordinate 
System, robot base coordinate, or work object coordinate. 

Included Path The included paths to be exported are listed here. Besides the 
selected path, service paths are also listed, in case you want to 
export service procedures together with the selected path. 
Check the service procedures that you want to export together.
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3.4.2. Process path

Continued
Importing a path

To import a path XML file into the station, follow these steps:

1. In Cutting browser, right-click a path, and select Import Path. A dialog box opens.

Specify a path file to import and click OK. A message box opens telling if a wrong type 

of XML file is selected.
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2. Click Open and the Import Path dialog box opens.

RSPP00034
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3.4.2. Process path

Continued
3. Complete the dialog box and click OK. A new path will be imported.

NOTE! The rules about creating new data are the same as described in Importing a part 

program on page 37.

Object Description

Description Describes the name of the part, the station, and the task. Read-
only.

Exported With Reference 
Frame

Reference used when the part program is exported. Read-only.

Import Reference Frame A reference to import part program. This affects the position and 
rotation values of these targets. The references can be World 
Coordinate, User Coordinate System, robot base coordinate, or 
work object coordinate.

Tool Select the tool for the part program. If left blank, the tool from the 
file will be used.

WorkObject Select workobject for targets in the part program. If left blank, 
the workobject from the file will be used.

Module Name The synchronized RAPID module of the part program

Path Name The name of the imported part.
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3.5. Setup and service procedures

Overview

The setup and service procedure nodes provide holders for motion paths that neither fit into 

a part program nor include cutting paths. For example, most stations require a path for moving 

the robot to its home position.

Further examples of setup and service procedures for an cutting system include motion paths 

for the following:

• To and from the home position and the BullEyes TCP calibration device (service 

procedure)

• To and from the home position (service procedure)

• To and from the home position and the service station (service procedure)

• Including targets for frame definition of the IRBP positioner (setup procedure)

• Including targets for TCP definition with the BullEyes TCP calibration device (setup 

procedure)

Shortcut menus from the Setup Procedures node

Node Menu Description

Setup 
Procedure

Create Setup 
Path

Inserts a new setup path node in the tree structure.

NOTE! You can also access this function from the 
Cutting ribbon-tab.

Import Path Import a path XML file into station as a setup path.
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3 Cutting Browser

3.5. Setup and service procedures

Continued
Shortcut menus from the Service Procedures node

Setup Path Properties Modifies the properties of setup path with a dialog box. 
The contents of the dialog box are the same as in 
Create Setup Path dialog box.

Open/Close Opens the path in the path view. Not available on an 
open path.

Closes an open path, removing it from the path view. 
Only available on an open path.

Create Setup 
Path

Inserts a new setup path node into the tree structure.

NOTE! You can also access this function from the 
Cutting ribbon-tab.

Synchronize to 
VC

Synchronizes the selected path to the virtual controller.

Export Path Export path into a XML file. The default name of the file 
consists of task name and path name. An dialog box will 
appear for users to specify the exporting reference 
frame. 

See Exporting a path on page 42for detailed descrip-
tion.

Import Path Import XML path file into the station as a setup path. A 
dialog box opens for specifying import reference, tool, 
workobject, path name and module name.

Please see Importing a path on page 44for detailed 
description.

Visible A check mark indicates that the selected path is visible.

Not available on an open path.

Delete Closes an open path, removing it from the path view. 
Only available on an open path.

Node Menu Description

Node Menu Description

Service 
Procedure

Create Service 
Path

Inserts a new service path node in the tree structure.

NOTE! You can also access this function from the 
Cutting ribbon-tab.

Import Path Import a path XML file into station as a service path.
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3 Cutting Browser

3.5. Setup and service procedures

Continued
Creating a setup/service path

RSPP00035

Service Path Properties Modifies the properties of service path with a dialog 
box. The contents of the dialog box are the same as in 
the Create Service Path dialog box.

Open/Close Opens the path in the path view. Not available on an 
open path.

Closes an open path, removing it from the path view. 
Only available on an open path.

Create Service 
Path

Inserts a new service path node into the tree structure.

NOTE! You can also access this function from the 
Cutting ribbon-tab.

Synchronize to 
VC

Synchronizes the selected path to the virtual controller.

Export Path Export path into a XML file. The default name of the file 
consists of task name and path name. A dialog box 
opens for specifying the exporting reference frame. 

See Exporting a path on page 42 for detailed descrip-
tion.

Import Path Import XML path file into station, as a service path. A 
dialog box opens for specifying import reference, tool, 
workobject, path name, and module name.

See Importing a path on page 44for detailed descrip-
tion.

Visible A check mark indicates that the selected path is visible.

Not available on an open path.

Delete Closes an open path, removing it from the path view. 
Only available on an open path.

Node Menu Description
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3 Cutting Browser

3.5. Setup and service procedures

Continued
To create a Setup/Service path, follow these steps:

1. In the Cutting browser, right-click the setup/service procedures node or a setup/service 

path node and click Create Setup Path Service or Create Service Path, or click 

Setup Path or Service Path in the Cutting ribbon-tab to open the dialog box.

2. Complete the dialog box and click OK. If any RAPID name is invalid, then clicking 

OK will not close the dialog box.

NOTE!

After completing the dialog box, you can view the created setup/service path in the tree 

structure of the Cutting browser. If the path is selected to be run in multi-tasks, a new setup/

service node with the same name will be created under each task. This is very useful in a 

MultiMove station.

Object Description

Path Name Enter a name for the created path.

Module Name Synchronize RAPID module. Default module is mSetup.

Include Menu Data If selected, the menudata will also be created. The information 
in the menudata is as the following inputs from the dialog box.

Category Input a category string for the setup/service path.

Description Get automatic update when entering a new setup/service path.

Run in tasks Select tasks in which the new create path runs. Useful when 
used in a MultiMove program.

Valid on Stations Select stations for which this part data will be valid. The value 
should be a number from 1 to 8.

Valid at Position Select stations for which this part data will be valid. The value 
should be a number from 1 to 8.

Allow After Error If selected, this menu item will be shown after an error occurs.

Block Other Tasks If selected, all other tasks will be blocked during the execution 
of this path.

PLC Code A unique integer number, to indicate the ID for PLC interface.

Image File Select an image for the new created setup/service path. This 
image can be shown on Production Manager of the FlexPen-
dant.
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3 Cutting Browser

3.5. Setup and service procedures
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4 Cutting path view

4.1. Overview
4 Cutting path view

4.1. Overview

Overview

The path view displays the targets in a path by representing them with Instruction icons on 

page 52. The large arrow head indicates the start of a path.

When a program contains several paths, the first instruction in the path view is the last 

instruction of the preceding path. This enables you to verify that the robot can bridge the 

paths.

The path view holds The Path View toolbar on page 55, which has menus and buttons for the 

most frequently used commands. You can use the Create menu to add or insert instructions 

and the Modify menu to manipulate targets and axes. The Path Player can execute individual 

targets or entire paths.

The path view also contains a Shortcut menu on page 57 and a number of Multi-Selection 

Operations on page 88to modify multiple targets.
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4 Cutting path view

4.2. Instruction icons
4.2. Instruction icons

Overview

An instruction icon shows the type (shape), motion (arrow) and status (color) of each target. 

Targets are sequenced from left to right in two levels: the lower level represents process 

sections, such as cutting paths and search sequences, while the upper level represents air 

move sections, which typically connect process sections.

Instruction icons
The following table describes the icon shapes:

The following table describes the arrows:

The following table describes the color coding. The goal is to turn all the status fields green 
before synchronizing the paths to the virtual controller.

Icon Description

RSPP00036

Target

RSPP00037

Process start target

Icon Description

RSPP00038

Linear move

RSPP00039

Joint move

RSPP00040

Absolute joint move

RSPP00041

Circular move

Icon Description

RSPP00042

White = unknown status

RSPP00043

Green = target verified
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4 Cutting path view

4.2. Instruction icons

Continued
The following table describes examples of the above:

The following table describes the instruction levels:

The following table describes the non-motion instructions:

RSPP00044

Yellow = solution found, but not verified

RSPP00045

Red = no solution, or target out of reach

RSPP00046

Blue = non-motion instruction

Icon Description

RSPP00048

Linear move, process start target, solution found but not verified

RSPP00049

Joint move, target verified

RSPP00050

Circular move, no solution or out of reach

RSPP00051

Linear move, unknown status

Level Instruction type Instruction

Upper Air MoveL, MoveJ

Lower Process CutLStart, CutL, CutC, CutLEnd, 
CutCEnd, Search_1D, 

Icon Description

RSPP00052

WaitSyncTask

RSPP00053

SyncMoveOn

RSPP00054

SyncMoveOff

RSPP00055

Miscellaneous RAPID

Icon Description
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4 Cutting path view

4.2. Instruction icons

Continued
Example

RSPP00056

PROC My Path

MoveJ

SearchL

SearchL

MoveL

MoveL

WaitSyncTask

MoveJ

CutLStart

CutL

CutC

CutCEnd

MoveL

MoveJ

SyncMoveOn

CutLStart

CutL

SetDO

CutL

CutLEnd

SyncMoveOff

MoveL

MoveJ

ENDPROC
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4 Cutting path view

4.3. The Path View toolbar
4.3. The Path View toolbar

Overview

The path view toolbar has buttons for the most frequently used commands.

Path View toolbar

Icon Description

RSPP00057

The Set View Center button sets the view center automatically 
to the selected target in the path view or the active TCP (if no 
target is selected).

The Create menu This menu contains the following commands:

• Create Free Form Cutting on page 59

• Create CutL/C instruction on page 63

• Create Air instruction on page 66

• Create ABS joint target on page 69

• Create an Action instruction on page 72

• Create Procedure Call on page 73

The Shapes menu This menu contains the following commands:

• Cut Circle Instruction on page 75

• Cut Wrist Circle Instruction on page 76

• Cut Rectangle Instruction on page 77

• Cut Slot Instruction on page 78

• Cut Hexagon Instruction on page 79

• Cut 2D shape Instruction on page 80.

The Modify menu This menu contains the following commands:

• Modify instruction on page 84.

• Modify target on page 85

• Modify Jointtarget / External Axes on page 86

• Modify Reference Vector on page 87

• Modify Selected Targets on page 88

The Configuration menu This menu contains the following commands:

• Check Reach on page 101.

• Set Configuration on page 102.

RSPP00058

The Arm button opens a dialog box similar to the one opened 
by clicking Set Configuration on page 102.

The image on the Arm button also indicates the active Arm con-
figuration of the target.

RSPP00059

The Wrist button opens a dialog box similar to the one opened 
by clicking Set Configuration on page 102.

The image on the Wrist button also indicates the active Wrist 
configuration of the target.

RSPP00060

The Tool button opens a dialog box similar to the one opened 
by clicking Set Configuration on page 102.

The image on the Tool button also indicates the active Tool con-
figuration of the target.
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4 Cutting path view

4.3. The Path View toolbar

Continued
RSPP00061

The Jump to Target button jumps the robot with active TCP to 
the selected target. It gives you a chance to view cutting head 
angles and detect possible collisions with the robot. 

• A successful result turns the target yellow and moves the 
robot one discrete step towards the target.

• An unsuccessful result turns the target red and leaves 
the robot in its current position.

RSPP00062

The Move to Target button moves the robot to the selected 
target from the previous target in the target list, checks for reach 
and sets the robot configuration. You can also select a range of 
targets and move the robot in sequential order down the target 
list. 

• A successful result turns the target green and moves the 
robot continuously towards the target. 

• An unsuccessful result turns the target red and leaves 
the robot in its current position.

NOTE! The virtual controller is not running when executing this 
command.

RSPP00062

The Execute Move Instruction button executes the path as-
sociated with the selected target. It is only effective on the target 
generated by commands in the Shapes menu.

RSPP00064

The Simulate button synchronizes the opened paths to the 
virtual controller and executes the paths in the virtual controller.

The Options menu The menu contains the following options related with Simulate:

• Save As View (Default value: Cleared).

• Enable Log (Default value: Checked)

Check or clear the check boxes to enable or disable the options. 

See The Options Menu on page 104for more information.

RSPP00065

The Speed Control list applies only to Jump to and Move to. 
Simulation speed is determined by the RAPID program.

RSPP00066

The index and name of the active object.

Icon Description
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4 Cutting path view

4.4. Shortcut menu
4.4. Shortcut menu

Overview

The table describes the commands of the path view shortcut menu.

Object Description

Create See The Create menu on page 58.

Shapes See The Shape Menu on page 74.

Modify See The Modify menu on page 84.

Check Reach See Check Reach on page 101.

Jump To See The Path View toolbar on page 55.

Move To See The Path View toolbar on page 55.

Show Item Info Displays instruction, the path angle and tool angle for the 
selected item.

Set Target Reference as 
UCS

Sets the target referenced in the instruction as User Coordinate 
System.

Delete Deletes the selected item.

Modify/Convert to Linear 
Move

Converts a MoveJ instruction to a MoveL instruction.

Modify/Convert to Joint 
Move

Converts a MoveL instruction to a MoveJ instruction.

Modify/Convert to Air Converts an approach or depart instruction to an air instruction, 
and disconnects it from the first or last target, respectively, in a 
cutting path.

Modify/Convert to 
Approach

Converts an air instruction to an approach or depart instruction, 
and connects it to the first or last target, respectively, in a seam.

Export Process 
Section(s)

Export one or more process sections into XML path file. Only 
available on Process Start target, or range selections with even 
pairs of Process Start and Process End targets.

Import Process 
Section(s)

Import path XML path into station, as one or more new cutting 
in the path. Only available on non-process targets.

Select Instructions Switch to select the corresponding instructions in RobotStudio 
environment when you select a range of icons in path view. You 
may see the effect by checking the Modify ribbon-tab of Robot-
Studio.
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4 Cutting path view

4.5.1. Overview
4.5 The Create menu

4.5.1. Overview

Overview

This menu contains the following commands:

• Create Free Form Cutting on page 59.

• Create CutL/C instruction on page 63.

• Create Air instruction on page 66.

• Create ABS joint target on page 69.

• Create an Action instruction on page 72.

• Create Procedure Call on page 73

NOTE!

• The contents of the Create menu will change depending on selected target.

• The Create dialog boxes can not exist together with other dialog boxes brought from 

the path view. They will close other dialog boxes automatically, and vice versa. Thus, 

make sure that changes in dialog boxes have been applied before a create dialog is 

opened.
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4 Cutting path view

4.5.2. Create Free Form Cutting
4.5.2. Create Free Form Cutting

Overview

This command creates a continuous path that includes the following targets:

• Approach Move (optional)

• Process start 

• Process Via

• Process End

• Depart Move (optional)

This command is available after a path or the last instruction in a free from cutting path has 

been selected.

Create Free Form Path Data File

To create a free form cutting path, you must specify/import a corresponding path data file 

which is created by clicking ribbon button Path Section in the Create group in Cutting tab.

RSPP00067

Object Description

List Box (Marked with 1) Show the selected continuous adjacent edgesfromtheCAD 
model.

Rotation around X Specify the rotation angle around X axis when saving the data 
file.

Invert Normal Indicate whether inverting the current normal for each edge.

Start position in first 
segment

Specify the start position in the first edgewhensavingthedata 
file.

End position in last 
segment

Specify the end position in the last edge when saving the data 
file.
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4 Cutting path view

4.5.2. Create Free Form Cutting

Continued
Remove Last Remove the last edge in the list box.

Reverse Path Reverse the edges items in the list box.

Show Points Indicate whether showing approximated points in the geome-try 
window.

Task Select the current task object.

Reference Frame

Max Lin Dist Specify the maximum length for linear approximation.

Max Circ Dist Specify the maximum length for circular approximation.

Corner Appr Dist Specify the edge length of the corner for linear approximation.

This value should be greater than the value of "Min Dist", 
otherwise it has no effect on approximation.

Therefore if the user don't want insert any corner into the linear 
paths, this value can be set with 0.

Max Radius Specify the maximum radius for circular approximation.

Min Dist Specify the minimum length for linear approximation.

If one linear path's length is shorter than this specified value, 
this linear path would be eliminated in the resultant paths.

 Instead, a new linear path, which starts from the end position of 
the previous valid path and ends to the start position of the next 
valid path, will be inserted into the path list.

Chord Dev Specify the maximum chord value for circular approximation.

Linear Apply the linear approximation on current selected edges.

Circular Apply the circular approximation on current selected edges.

If one edge failed to apply the circular approximation, it would 
automatically change to apply the linear approximation.

Constant Apply the constant length approximation on current selected 
edges.

Create Data File Save the data of all edges in the list box into a XML file which 
will be used for creating free form cutting path.

Clear Clear all items in the list box.

Object Description
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4 Cutting path view

4.5.2. Create Free Form Cutting

Continued
The Create Import Process Section(s) Dialog Box

After specifying the correct free form path data file, the Create Import Process Section(s) 

dialog box, which is composed with two tab-pages, is shown up.

The first page contains parameters that are static among different cutting, and users don't 

usually change.

RSPP00068

Object Description

Cutting name The name of the new cutting.

Process Template Select the process template of the new cutting. Click on i on the 
right side of the template, and a message box will display the 
process parameters of the template, such as cut speed, wire 
feed speed, voltage, and so on.

Tool Select tool of the cutting.

Work Object Select work object for the targets of the new cutting.

Use Target Settings Indicate whether using target settings.

Offset X, Y, Z The offset distance of the process targets with their RCS.

Angle X, Y, Z The work angle, travel angle, and spin angle of the process 
targets, in relation to their RCS.

Modify Approach If selected, the new cutting will include an approach target 
before Process Start point.

Modify Depart If selected, the new cutting will include a depart target after 
Process End point.
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4 Cutting path view

4.5.2. Create Free Form Cutting

Continued
The second page contains parameters that are usually variable among among different cutting 

paths: 

RSPP00069

Creating a Free Form Cutting path

To create a free form cutting path, follow these steps:

1. Create the path data file if it doesn't exist.

2. Import the path data file.

3. In the Cutting name box, enter the name for the cutting or use the default name.

4. In the Process list, select the process template for the cutting.

5. In the Tool list, select the tool for the cutting.

6. In the Work Object list, select the work object for the cutting.

7. If the Use Target Settings checkbox is enabled, set the appropriate value for each item.

Related Information

The Path View toolbar on page 55.

Object Description

Description Input the description text for the new cutting. 

Exported with 
Reference Frame

Input the reference text.

Import Reference Frame Specify the reference frame.
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4 Cutting path view

4.5.3. Create CutL/C instruction
4.5.3. Create CutL/C instruction

Overview

This command, which is available only when a process instruction is selected, adds cut 

instructions to a free form path.
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4 Cutting path view

4.5.3. Create CutL/C instruction

Continued
Creating a CutL/C instruction

To create a CutL/C instruction, follow these steps:

1. In the Path View, select the process start target and then in the Create menu, click CutL/

C Instruction.

2. In the graphics window, click in the middle of the free form path to add a new cut.

RSPP00070

3. Optionally, select the Auto OK check box to automatically create the cut instruction when 

valid input has been entered, and then click OK. 

A new target is displayed in the graphics window, and an instruction icon is added to the 

path view.

RSPP00071
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4 Cutting path view

4.5.3. Create CutL/C instruction

Continued
NOTE! To make a smooth movement from the previous target to the new target, the 

default angle of the target is the same as the previous one.

Related Information

The Path View toolbar on page 55.
653HAC043509-001  Revision: -     



4 Cutting path view

4.5.4. Create Air instruction
4.5.4. Create Air instruction

Overview

Air instructions can be added to a path.

Creating an Air instruction

To create an air instruction, follow these steps:

1. In the Path View, select the last target. In the Create menu, click Create Air Instruction.

2. In the graphics window, move the robot’s TCP to the desired position. In the dialog box, 

click Present. This will read the current position of the active tool into the Data Input 

area.
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4 Cutting path view

4.5.4. Create Air instruction

Continued
RSPP00072

3. In the dialog box, click OK. A new target is displayed in the graphics window, and an 

instruction icon is added to the path view.

If the Auto OK check box is selected, the air instruction is automatically created when a 

valid input has been entered.
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4 Cutting path view

4.5.4. Create Air instruction

Continued
RSPP00073

Related Information

The Path View toolbar on page 55.
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4 Cutting path view

4.5.5. Create ABS joint target
4.5.5. Create ABS joint target

Overview

Absolute joint instructions can be added to a path.
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4 Cutting path view

4.5.5. Create ABS joint target

Continued
Creating a Jointtarget

To create a jointtarget, follow these steps:

1. In the path view, select the last target. In the Create menu, click Absolute Joint 

Instruction.

RSPP00074

2. Jog the robot to an arbitrary position and click OK.

A new jointtarget is displayed in the graphics window, and an instruction icon is added to 

the path view.
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4 Cutting path view

4.5.5. Create ABS joint target

Continued
RSPP00075

Related Information

The Path View toolbar on page 55.
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4 Cutting path view

4.5.6. Create an Action instruction
4.5.6. Create an Action instruction

Overview

Absolute joint instructions can be added to a path.

Creating an Action Instruction

To create an action instruction, follow these steps:

1. In the path view, select the last target. In the Create menu, click Action Instruction.

2. In the Create Action Instruction dialog box, select an instruction from the list, and then 

click OK.

A blue instruction icon is added to the path view.

Related Information

The Path View toolbar on page 55.
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4 Cutting path view

4.5.7. Create Procedure Call
4.5.7. Create Procedure Call

Overview

Procedure calls can be added to a path.

Creating Procedure Call

To create a Procedure Call, follow these steps:

1. In the path view, select the last target. In the Create menu, click Procedure Call.

2. In the Create Procedure Call dialog box, select an path procedure name from the list, and 

then click OK.

A blue instruction icon is added to the path view.

Related Information

The Path View toolbar on page 55.
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4 Cutting path view

4.6.1. Common Items Used in Shape Menu
4.6  The Shape Menu

4.6.1. Common Items Used in Shape Menu

Overview

All commands in the Shapes menu are used to create cutting instructions based on specified 

geometry features. The geometry feature can be defined by only several mouse click actions 

on the CAD model in the geometry window.

All instructions created by this menu are applied on the 2D cutting path.

There are several common items used in the dialog box corresponding to each command in 

the Shapes menu.

Object Description

Active 
Process

Specify the process template for the new cutting instruction.

Tool Specify the tool object for the new cutting instruction.

Work 
Object

Specify the work object for the new cutting instruction.

Reference Specify the reference frame for the new cutting instruction.

Auto OK If checked, automatically accomplish the creation after the geometry feature 
was specified.

Present Specify the current position as the selected input point.
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4 Cutting path view

4.6.2. Cut Circle Instruction
4.6.2. Cut Circle Instruction

The three points, Point 1, Point 2 and Point 3, define the circle feature in the dialog box.

RSPP00076
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4 Cutting path view

4.6.3. Cut Wrist Circle Instruction
4.6.3. Cut Wrist Circle Instruction

The dialog box of Cut Wrist Circle Instruction is very similar to Cut Circle Instruction's, 

only with the different list items of Active Process in the dialog box.

SPP00077
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4 Cutting path view

4.6.4. Cut Rectangle Instruction
4.6.4. Cut Rectangle Instruction

The four points, point1, point2, point3 and point4, define the rectangle feature in the dialog 

box.

RSPP00078
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4 Cutting path view

4.6.5. Cut Slot Instruction
4.6.5. Cut Slot Instruction

The three points, Point 1, Point 2 and Point 3, define the slot feature in the dialog box.

RSPP00079
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4 Cutting path view

4.6.6. Cut Hexagon Instruction
4.6.6. Cut Hexagon Instruction

The three points, Point 1, Point 2 and Point 3, define the hexagon feature in the dialog box.

RSPP00080
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4 Cutting path view

4.6.7. Cut 2D shape Instruction
4.6.7. Cut 2D shape Instruction

Create Shape Data From Edges Dialog Box

To create a 2D shape instruction, you must specify a corresponding shape data file which is 

created by clicking ribbon button 2D Shape Data in the Create group in Cutting tab.

The Create Shape Data From Edges dialog box is composed with two tab-pages. The first 

page contains parameters representing shape definitions.

RSPP00081

Object Description

List Box Show the selected face's edges from the CAD model.

Remove 
Last

Remove the last edge in the list box.

Clear Clear all items in the list box.

Reverse 
Path

Reverse the edges items in the list box.

Reference 
Coordinate 
System

Specify the reference coordinate system.

Position Specify the reference point for the shape data.

This point is the original point of the path frame for the shape data.

X vector Specify the direction of X axis for the path frame.

Path Offset Specify the offset of the reference point for the shape data.
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4 Cutting path view

4.6.7. Cut 2D shape Instruction

Continued
Show Path 
Frame

Show the path frame in the geometry window.

Show Tool Show the tool in the geometry window.

Center Set the Location and X vector as the geometry center of the selected face.

Max Lin 
Dist

Specify the maximum length for linear approximation.

Max Circ 
Dist

Specify the maximum length for circular approximation.

Corner 
Appr Dist

 Specify the edge length of the corner for linear approximation.

This value should be greater than the value of "Min Dist", otherwise it has no 
effect on approximation.

Therefore if the user don't want insert any corner into the linear paths, this 
value can be set with 0.

Max Radius Specify the maximum radius for circular approximation.

Min Dist Specify the minimum length for linear approximation.

If one linear path's length is shorter than this specified value, this linear path 
would be eliminated in the resultant paths. Instead, a new linear path, which 
starts from the end position of the previous valid path and ends to the start 
position of the next valid path, will be inserted into the path list.

Chord Dev Specify the maximum chord value for circular approximation.

Linear Apply the linear approximation on current selected edges.

Circular Apply the circular approximation on current selected edges.

If one edge failed to apply the circular approximation, it would automatically 
change to apply the linear approximation.

Object Description
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4 Cutting path view

4.6.7. Cut 2D shape Instruction

Continued
The second page contains some cutting parameters for preview, and you can only switch to 

the second page after selecting the face and set the Location in the first page.

RSPP00082

Object Description

Entry Point Specify the point as the entry point of the shape data.

Show Entry 
Point

Show the entry point in the geometry window.

Pick 
Nearest 
Point

Automatically select the nearest point in the Entry Point list when the user 
clicks the mouse in the geometry window.

Lead Data Specify the leaddata for the shape data for preview in the geometry window.

Button … Modify the value of Lead Data.

Cut 
Direction

Specify the cut direction for the shape data for preview in the geometry 
window.

Create Cut Export the shape data as a .cad file and create a 2D shape instruction with that 
.cad file.

NOTE1: The exported shape data file must be located in the default folder. 
(HOME\\CwCadShapes)

NOTE2: The creating action is only successful when you have opened a path 
program in the Cutting browser tree.

Create Data 
File

Export the shape data as a .cad file.

NOTE: The exported shape data file must be located in the default folder. 
(HOME\\CwCadShapes)
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4 Cutting path view

4.6.7. Cut 2D shape Instruction

Continued
Create Cut… Dialog Box

RSPP00083

Object Description

Shape Data Specify the shape data file (.cad file) created by the Create Shape Data From 
Edges dialog box.NOTE: The shape data must be located in the default folder 
"Controller System Path"\\HOME\\CwCadShapes.

Point 1 Specify the reference point for the shape data. This point is corresponding to 
the Location in the first page of the Create Shape Data From Edges dialog 
box.
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4 Cutting path view

4.7.1. Modify instruction
4.7 The Modify menu

4.7.1. Modify instruction

Overview

Most instructions have arguments that specify how the instruction must be performed. For 

example, the arguments of the LsCutCricleJ instruction specify the circle geometry feature 

with which the robot moves along the circle path. In the Modify Instruction dialog box, you 

can display and change these arguments.

The Modify Instruction Dialog Box

RSPP00084

Related Information

• The Path View toolbar on page 55

• Application Manual - RW Cutting
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4 Cutting path view

4.7.2. Modify target
4.7.2. Modify target

The Modify Target Dialog Box

The Modify Target dialog box is used to edit target positions and orientations.

RSPP00085

Related Information

The Path View toolbar on page 55.

Object Description

Reference The coordinate system of the target reference. All available 
frames in the station are listed. It affects the values shown for 
RCS's position and rotation.

Target Reference (RCS) The position and rotation of the RCS.

Highlight the arrow head on the right to select a new position in 
graphic interface, or manually enter values to modify.

NOTE! Since Approach/Depart targets' RCS align with Start/
End target, their RCS are not directly modifiable.

For rotation of process targets, such as Start, Via, and End 
targets, only rotating around X axis is allowed. For other targets, 
rotation around x, y, and z axis are all available.

Link to target If selected, modifications made on RCS will also affect the target 
in world frame, and the offset and angle of the target in its RCS 
keeps unchanged.

Normally the target is set to be linked with it's RCS.

Target The offset and angle values are relative to the target reference. 
For information on tool angles. 
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4 Cutting path view

4.7.3. Modify Jointtarget / External Axes
4.7.3. Modify Jointtarget / External Axes

Overview

This dialog box is used to modify the jointtarget or external axis values of a selected target. 

Jointtargets are used in instructions such as MoveAbsJ and MoveExtJ.

Modifying a Jointtarget or External Axes

To modify a jointtarget or external axis, follow these steps:

1. In the Modify menu, click Jointtarget / External Axes.

2. Click Present to obtain the external axis values of the active robot, and then move the 

slide bars to jog the robot.

3. Click Apply.

Related Information

The Path View toolbar on page 55.
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4 Cutting path view

4.7.4. Modify Reference Vector
4.7.4. Modify Reference Vector

Overview

This dialog box is used to modify the reference vector of a selected cutting instructions based 

on the geometry feature.

The Modify Reference Vector Dialog Box

RSPP00086

Object Description

Combox (Marked as 1) Select which available vector to be edited: X vector or Z vec-tor.

Editbox (Marked as 2) Set/Modify the value of current selected vector.
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4 Cutting path view

4.7.5. Multi-Selection Operations
4.7.5. Multi-Selection Operations

Overview

Multiple targets may be selected in the path view by clicking one target, pressing SHIFT and 

then clicking another target. All targets in between will also be highlighted grey.

Depending on the targets selected, the following additional operations may be available from 

the shortcut menu.

Modify Selected Targets

This command shows a dialog box containing several useful function options which can be 

respectively performed on multi-selected free form path targets.

RSPP00087
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4 Cutting path view

4.7.5. Multi-Selection Operations

Continued
Group Object Description

Operations Copy X axis of 
current se-lected 
(Z axis fixed)

If this option is enabled, the group Current Selected 
Target, representing the first clicking target in the 
selected target list, is shown up.

For the detail description of this option, see the option 
Spin X to Selected in Optimize Selected Target on 
page 94.

Copy orientation 
of current 
selected

If this option is enabled, the group Current Selected 
Target is shown up.

For the detail description of this option, see the option 
Copy Rotation from Selected in Optimize Selected 
Target on page 94.

Modify offset/
angle in RCS

If this option is enabled, the group Current Selected 
Target is shown up.

For the detail description of this option, see Target 
Offset/Angle on Selection on page 91.

Interpolation 
Orientation (Z 
axis fixed)

If this option is enabled, two groups First Se-lected 
Motion Target and Last Selected Mo-tions Target, rep-
resenting respectively the first and last motion target 
in the selected target list, are shown up.

For the detail description of this option, see the option 
Interpolate Orientation of Optimize Selected Target on 
page 94.

Interpolate Offset 
in RCS

If this option is enabled, two groups First Se-lected 
Motion Target and Last Selected Mo-tions Target are 
shown up.

For the detail description of this option, see the option 
Interpolate Targets Offset of Optimize Selected Target 
on page 94.

Current Selected 
Target /First 
Selected Motion 
Target /Last 
Selected Motion 
Target

Offset Specify the offset of the target in RCS.

Angle x.y.z Specify the angle of axis X, Y and Z respec-tively in 
RCS.
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4 Cutting path view

4.7.5. Multi-Selection Operations

Continued
Target Reference Position on Selection

RSPP00088

The following table describes the elements of the dialog box.

Target Reference Orientation on Selection

RSPP00089

Object Description

Reference The coordinate system of the target reference. All available 
frames in the system are listed.

Relative Select to perform a relative move of the target reference.

Link to target Select to move the selected targets together with RCS.

Position Enter the absolute position or relative move of the target 
reference. If you want to move the target reference in just one 
direction, clear the check boxes of the other axes.
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4 Cutting path view

4.7.5. Multi-Selection Operations

Continued
This command applies only to process instructions.

The following table describes the elements of the dialog box.

Target Offset/Angle on Selection

RSPP00090

This command offsets or rotates selected targets of process instructions a given distance or 

angle. This offset or angle is in relation to the target references coordinate system. If Relative 

is selected, the offset or angle will be in relation to the target itself. Clear the offset or angle 

directions in the tree nodes on the left side that have no bearing on the operation.

Object Description

Reference The coordinate system of the target reference. All available 
frames in the system are listed.

Relative Select to perform a relative reorientation of the approach vector.

Link to target Select to rotate the selected targets.

Modify Base Plate 
Normal

The arrowhead points to the current values of the base plate 
normal. Click Modify to enter a new vector or invert the current 
one. Alternatively, click the arrowhead to turn it black, and then 
click in the graphics window on the surface that will constitute 
the new base plate.
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4 Cutting path view

4.7.5. Multi-Selection Operations

Continued
External Axes Values on Selection

RSPP00091

This command sets the external axis values on all selected targets. If Relative is selected, the 

given value will be in relation to the current external axis values defined for each target. 

Convert to MultiMove Section

RSPP00092

RSPP00093
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4 Cutting path view

4.7.5. Multi-Selection Operations

Continued
It is possible to enter special commands for motion synchronization in the path view. These 

commands are represented by blue instruction icons and letter flags. Each letter represents a 

Sync ID, and two identical letters form a pair marking a synchronized MultiMove section.

Select all instructions to be included in the MultiMove section. From the context menu, select 

Modify/Convert to MultiMove Section. A dialog appears asking the user to define a Sync ID 

and a Task List. If there are no Sync IDs or Task Lists present in the station, you can create 

new by selecting Create new from the list. The necessary data will then be created 

automatically. When creating a new Task List, you will also be prompted to select the tasks 

to be included in the list.

For more information, see Application manual - MultiMove.

Stick-Out

RSPP00094

Object Description

Stick-Out This command modifies the position of the target offset as a 
function of stick-out. The value of the stick-out is based on the 
defined tool properties. It affects the tool position along its z 
axis.

Offset This value modifies the position of the target offset along its y 
axis.
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4 Cutting path view

4.7.5. Multi-Selection Operations

Continued
Optimize Selected Target

RSPP00095
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4 Cutting path view

4.7.5. Multi-Selection Operations

Continued
Option Description

Spin X Towards Robot 
Base

Spin the X axis of the targets towards the robot base.

Spin X to Selected This function can be used to orient a row of targets so the target 
x axes point in the same direction. The function will spin all 
marked targets around the z axes until the target x axes match 
the selected target x axis as close as possible.

Before using this function, the status is illustrated in the 
following picture.

RSPP00096

After using this function, the status is illustrated in the following 
picture.

RSPP00097
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4 Cutting path view

4.7.5. Multi-Selection Operations

Continued
Copy Rotation from 
Selected

This function copies the orientation of the selected target to all 
other marked targets. Depending on the type of target, only the 
appropriate part of the orientation is copied. For an air target, it 
is a complete copy. For a process target, only the orientation of 
the tool-x axis is copied. For a search target, the reference 
frame is aligned with the selected target z axis and the search 
target x axis is aligned with the selected x axis.

Before using this function, the status is illustrated in the 
following picture.

RSPP00098

After using this function, the status is illustrated in the following 
picture.

RSPP00099

Option Description
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4 Cutting path view

4.7.5. Multi-Selection Operations

Continued
Interpolate Orientation Interpolate orientations of targets based on the selected coordi-
nates.

• Interpolate in World (Z axis fixed): Set to interpolate 
the Z axis value of the Euler angles of the targets, in 
relative to world frame (i.e., external axes, if exist, are 
moved to calculate interpolation values).

• Interpolate in Object (Z axis fixed): Set to interpolate 
the Z axis of the Euler angles of the targets in object 
frame (work object), with Z axis fixed.

• Interpolate in RCS (Al axes): Set to interpolate the 
travel, work and spin angle of the targets in each RCS.

• Interpolate in RCS (Z axis fixed): Set to interpolate the 
spin angle of the targets in each RCS, with Z axis fixed.

RSPP00100

Interpolate Targets Offset Interpolate offsets of targets based on the selected coordi-
nates.

Interpolate External Axes This command interpolates the external axes for a select range 
based on the move distance between the tool robot points. The 
points can be either in the same path or in different open paths.

Option Description
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4 Cutting path view

4.7.5. Multi-Selection Operations

Continued
Interpolate Robot Wrist 
Axes

This command can be used to optimize air moves. The function 
tries to interpolate the robot wrist axes from the selected start 
target to the selected end target. The interpolation of the joint 
values is based on the move distance of the robot targets. All 
selected targets must have a solution before the operation is 
executed.

Before using this function, the status is illustrated in the 
following picture.

RSPP00101

After using this function, the status is illustrated in the following 
picture.

RSPP00102

Option Description
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4 Cutting path view

4.7.5. Multi-Selection Operations

Continued
Minimize Axes Movement Optimizes the spin angles of the selected motion items by 
minimizing the value change of robot joint moves. 

It searches for a best target orientation by evaluating multiple 
orientation values in the close range, based step angle. 

The weight value for each joint shows the importance of each 
joint in the minimization. 

Several checkings on joint moves can be enabled to filter out 
invalid targets.

• Axes Weight: Weight for this axis during searching axis. 

• Test Step size: The step value of the angle to search for 
best orientations of the target.

• Number of Tests: The maximum number of steps to 
search for best orientations.

• Min Angle Axis 5: The minimum angle of axis 5 to keep 
during searching. Set to a value large enough so that an 
orientation close to sigularity is not selected.

• Set Axis 2 Init value to 0: Set axis 2 to zero during 
searching.

• Check Sign Axis 5 for Joint Move: Keep the sign of 
axis 5 value during searching.

• Check Min Axis 5 Angle for Joint Move: Make axis 5 
minimum angle effective during searching.

RSPP00103

Option Description
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4 Cutting path view

4.7.5. Multi-Selection Operations

Continued
Pivot Target From TCP to 
RCS

Set the Z axis of the targets towards the tool. This is usually 
used in laser cutting.

• Min Angle (deg): Enter the minimum angle between z 
axis of the target and the RCS during pivoting. You may 
need this to keep the laser tool from cutting perpendicu-
larly onto the work piece surface.

• Max Angle (deg): Enter the maximum angle between z 
axis of the target and the RCS during pivoting. You may 
need this to make the cutting direction not too inclined 
towards work piece surface.

• Align Target X to Tool X: Check to also set the x axis of 
target to current x axis of the tool.

RSPP00104

The Apply button Click this button to apply your settings on the selected targets.

The Cancel button Click this button to cancel your settings in this editor.

Option Description
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4 Cutting path view

4.8.1. Check Reach
4.8 The Configuration Menu

4.8.1. Check Reach

Overview

This command checks whether the robot can reach a target. A successful result turns the target 

yellow, while an unsuccessful result turns it red.

Related information

The Path View toolbar on page 55.
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4 Cutting path view

4.8.2. Set Configuration
4.8.2. Set Configuration

Overview

It is possible to attain the same target position and orientation in several different ways, using 

different sets of axis angles. We call this the settings of different robot configurations. 

In Cutting PowerPac, robot configuration can be set for individual targets. The system 

calculates a configuration based on your selections, after which values are displayed.

The Set Configuration Dialog Box

This dialog box requires that you select three positions, one each for the robot arm, wrist and 

tool, before clicking Apply.

RSPP00105

The following table describes the elements of the dialog box:

Object Description

Arm The group is used to specify whether the robot wrist is in front of 
or behind axis 1, and whether the elbow is up or down.

Wrist This group is used to specify whether axis 4 will be turned 
positive or negative.

Tool This group is used to specify whether axis 6 will be turned 
positive or negative. If neutral is selected, the configuration of 
axis 6 will be determined by the arm and wrist selections.

New This list displays the configuration and joint values for a selected 
configuration, as well as alternatives.

Current This box displays the configuration currently stored in the 
selected target.

Change This box calculates the difference in joint values between the 
currently selected target and the preceding target in the path.
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4 Cutting path view

4.8.2. Set Configuration

Continued
TIP!

Have this dialog box and the Modify Target dialog box open at the same time. The 

configuration will then be automatically recalculated when the target is modified, which will 

help you determine how much you can adjust the target while keeping it within reach.

How to Set Configuration

Cutting PowerPac provides two ways to set a configuration for a target.

• Specify a configuration setting by selecting a combination of arm, wrist and tool 

configuration among the symbols on the control. The settings will be used to find the 

robot configuration that fits the selection best. 

• Manually select a robot configuration among all the possibilities given. This is done 

by selecting one of the robot configurations in the drop-down New. The configuration 

setting controls will then be updated accordingly.

When selecting a configuration, the selected symbol gets a frame around it, and the selection 

process will make the background white for the valid configuration that was selected. If the 

two (the frame and the white background) does not coincide, the selection could not be 

fulfilled.

RSPP00105_1

TIP!

An easy way to set the configuration for a cutting path:

1. Create a cutting path with the approach point as a joint move. Make all other moves 

linear

2. Set the configuration for the first target (the joint move).

3. Run through all the targets using the Move To function.

4. If there is a problem, modify the configuration of the first target and repeat the step 3.

Related Information

The Path View toolbar on page 55.
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4 Cutting path view

4.9. The Options Menu
4.9. The Options Menu

Overview

Select simulation options for the executed paths.

Save As Viewer

Use this procedure to save the simulation of the executed paths as a RobotStudio viewer file:

1. On the path view toolbar, select the check box of Save As Viewer from the Options 

menu. 

2. Click the Simulate button.

When the execution finishes, the Save As dialog box opens.

3. In the dialog box, specify the name and location for the viewer file.

4. Click Save.

Enable Log

Use this procedure to enable log:

1. On the path view toolbar, select the check box of Enable Log from the Options menu. 

2. Click the Simulate button.
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4 Cutting path view

4.9. The Options Menu

Continued
When the execution finishes, the Simulate Log window opens.

RSPP00106

3. View the simulate logs in this window.

Item Description

Collisions Collision events happened during simulation in RobotStudio 3D 
environment are listed here. 

You need to first create collision set including interesting objects 
by using RobotStudio functions.

Events RobotStudio and Virtual Controller events, for example, motor 
on/off, I/O changes, program start/stop, raised during simulation 
are listed here.

Robot Motions Data about TCP robots' motion details during simulation are 
listed here. 

Each data item represents the running robot motion information 
on a simulation step, including time stamp, TCP position, joint 
angles and joint value percentage relative to the respective joint 
limits.

External Axes Motions Data about external axes' motion details during simulation are 
listed here. 

Each data item represents the running external axes' motion 
information on a simulation step, including time stamp, and joint 
angles.

Play Controls Controls to play, pause and reverse play the log.

Auto JumpTo Check to enable robots' automatic JumpTo when an data item 
is selected by keyboard or mouse clicking.
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4 Cutting path view

4.10. Export Process Section
4.10. Export Process Section

Overview

One or more cutting paths can be exported as a XML file, and then imported into other part 

programs in the same or different station. This feature greatly reduces duplicate work when 

paths between parts or stations are similar.
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4 Cutting path view

4.10. Export Process Section

Continued
How to Export a Process Section

To export process sections, follow these steps:

1. To export a single cutting path, right click on the Process Start target, or select a complete 

process section. To export multiple cutting paths, select a complete range with equal 

numbers of Start and End targets. Right click, and select Export Process Section(s).

If a single process section is selected, a user message will appear for you to select if the 

path should be saved as a template. 

RSPP00107

If a process section is saved as template, you will be able to modify the approach/depart 

offset, path angle/offset when importing the saved file. Otherwise, you will only be able 

to import and create new path targets as they were exported. 

A dialog box appears.

2. Specify the XML file name and directory. If a path is saved as template, the default name 

should be "Template_" + Task name + Path name + "Ind_" + index of first target + "_" 

+ index of last target; otherwise, the name is "Section_" + Task name + Path name + 

"Ind_" + index of first target + "_" + index of last target. The default directory is under 

the "/My Documents/RobotStudio/Stations".

RSPP00108
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4 Cutting path view

4.10. Export Process Section

Continued
3. Click Save and an exporting dialog box opens.

4. Complete the dialog box, click OK, and an XML file will be created.

RSPP00109

Object Description

Description Describes the name of the station, the task, and the start index 
and end index of the targets in the exported process section(s). 
Read-only.

Path The directory in which the file is stored. Read-only.

File Name The name of the saved file. Read-only.

Reference Frame Select a reference that the path targets in the process section(s) 
are related to. This affects the position and rotation values of 
these targets. The references can be World Coordinate, User 
Coordinate System, robot base coordinate, or work object 
coordinate, and also the RCS of the first target.

Included Paths The included paths to be exported are listed here.
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5 Cutting PowerPac workflow

5.1. Overview
5 Cutting PowerPac workflow 

5.1. Overview

Overview

This chapter id designed as a step-by-step guide to learn the sequence of work when you work 

with Cutting PowerPac.

Follow these steps:

• Build a Cutting station on page 110

• Create paths on page 112

• Verify and modify on page 113

• Synchronize on page 114

• Load program to real controller on page 115
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5 Cutting PowerPac workflow

5.2.1. Create a Cutting station using RobotStudio basic function
5.2 Build a Cutting station

5.2.1. Create a Cutting station using RobotStudio basic function

Overview

This section describes how to build a station by including the equipment necessary to create 

and simulate cutting programs.

The operation described in this section should be done before starting Cutting PowerPac. The 

detailed description can be available from Operating Manual - RobotStudio.

Creating a station with a robot system

You can create a station with a template system or with an existing system.

In most cases, a virtual controller is automatically started when you create a new station. 

Library files for the robot used by the system are then imported to the station.

Importing station components

The following table shows the workflow for importing station components. Perform only 

those steps applicable to your station.

Placing objects

The following table shows the workflow for placing the objects in the station.

Activity Description

Import a tool Click the lower split of the Import Library button from the Home 
ribbon-tab to display galleries of tools, and select the desired 
one.

Create tool data For achieving correct motions in robot programs, the 
parameters of the tool have to be specified in the tool data.

Click Tooldata on the Home ribbon-tab to open the Create 
Tooldata dialog box.

Import a work piece If you have CAD models of the work piece, you can import them 
by using Import Geometry on the Home ribbon-tab.

Create workobject For achieving correct motions in robot programs, the 
parameters of the work piece have to be specified in the 
workobject. 

Click Workobject on the Home ribbon-tab to open the Create 
Workobject dialog box.

Import other equipment If you have CAD models of the work piece, you can import them 
by using Import Geometry on the Home ribbon-tab.

Activity Description

Place objects If you are building a model of a real station, placing all objects 
with known position, find suitable placement.

Attach tools Attach the tools to the robot.

Attach work pieces to 
positioners

If positioner external axes are used, attach the work pieces to 
the positioners.

Test reachability Test if the robot can reach critical positions on the work piece.
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5 Cutting PowerPac workflow

5.2.2. Create an Cutting system using RobotStudio Basic Function
5.2.2. Create an Cutting system using RobotStudio Basic Function

Overview 

This section describes how you create and build systems to run on virtual and real controllers. 

These systems may even be downloaded to a real controller.

The system points out the robot models and options to use, and it also stores configurations 

and programs for the robots.

Building a new system

The following table shows the workflow for building a new system.

Activity Description

Start new controller system 
wizard

Click System Builder on the Online ribbon-tab, then click 
Create New in the dialog box to start the wizard.

Specify the name and 
location of the new system

To determine where on your computer to store the system you 
are creating.

Enter the RobotWare key 
and drive keys

The RobotWare keys determine which RobotWare versions and 
parts to use in the system. Creating a system to run on either 
IRC5 controller or virtual controllers requires at least two keys: 
one for the controller module and one for each drive module in 
the cabinet.

Add additional options You can add options here. Options require a license key and 
must be first imported to the media pool. 
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5 Cutting PowerPac workflow

5.3. Create paths
5.3. Create paths

Overview 

Programming with Cutting PowerPac is an iterative process, which typically begins with 

creating paths in the Cutting Browser. After opening the Path View, targets and instructions 

are added to the path using process and cut templates, combined with input from clicking at 

geometry objects in graphics window.

Creating Process Templates

Before the first cut path is created, you should create your own process template, modify the 

properties related with cutting parameters and motion instructions. 

See Process templates on page 26for detailed information,

Creating Process Paths

The following table shows the workflow:

Activity Description

1. Create a program part node in the 
Cutting Browser, which is the 
holder of process paths. 

See Part Programs node on page 32for the detailed 
procedure. 

2. Create a Process path. See Process path on page 40 for the detailed 
procedure.

3. Open the new created path in the 
Pact View and create targets and 
instructions.

See The Create menu on page 58and The Shape 
Menu on page 74 for the detailed procedure.
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5 Cutting PowerPac workflow

5.4. Verify and modify
5.4. Verify and modify

Overview

The instruction icons in the Path View will immediately alarm you if a target is out of reach 

by changing the target color to red. If the target is within the reach of the robot, the target color 

will change to yellow. 

The path is tested and verified by pushing the buttons in the toolbar of the path view. A 

successfully executed path will show all targets in green color. 

If the execution failed, it is possible to tune individual target position, orientation and other 

instruction attributes. Changes are checked by executing the path again. This procedure is 

repeated until all targets are tested and verified, that is all targets in the Path View are green.

Verifying

Modifying 

See The Modify menu on page 84 for a detailed description.

Activity Description

1. Open the selected path in the 
Path View to show targets and 
instructions.

2. Click the Jump to Target. Move to 
Target or Simulation button in the 
Pact View toolbar to test the 
selected targets.

See The Path View toolbar on page 55for the 
detailed description.
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5.5. Synchronize

Overview

It is important to keep the virtual controller and the Cutting PowerPac in perfect 

synchronization, which requires exact mapping between graphical objects and the RAPID 

language. For example, a target in the graphical environment will generate a robtarget 

definition and a move instruction in the virtual controller; a path including targets in the 

graphical environment will generate a routine with move instructions in the virtual controller.

Workflow

This is the basic workflow:

1. Create and modify targets and paths in the graphics environment.

2. Synchronize selected item to the virtual controller.

3. The resulting RAPID programs reside in the virtual controller and is ready for download 

to the real controller.

NOTE!

One of the features in Cutting PowerPac is the multilevel synchronization. You can choose to 

synchronize an entire task, a part program, or a path to the virtual controller.
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5.6. Load program to real controller

Overview

After synchronization, the fully functional RAPID program is generated in the virtual 

controller and can be saved to files and later downloaded to a real controller using the Online 

ribbon-tab. For more details about synchronization and downloading, consult the Operating 

manual - RobotStudio.

Workflow

This is the basic workflow:

1. Synchronize the tasks to the virtual controller to generate RAPID program.

2. Save the programs to files by clicking Save Program on the Cutting ribbon-tab.

3. Copy the files to the real controller or download to real controller by using the Online 

ribbon-tab. See Operating Manual - RobotStudio for detailed procedure.
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